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Chapter 1
Configuration and Compatibility

This chapter provides information on compatibility, licensing, and system requirements for this 
Tanner™ Tools release.

For more information on licensing and system configuration, refer to the Tanner Tools 
Administrator’s Guide.

The exact access date is February 2022.

The following issues are described in this chapter:

Windows Support  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7

RHEL Support . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7

Licensing . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7

Broken Links in PDF Documentation - (MG595892). . . . . . . . . . . . . . . . . . . . . . . . . . . . 8

Windows Support
Tanner Tools are no longer supported on Microsoft® Windows® 7, effective January 2020, 
coinciding with the end-of-life date for Windows 7.

Tanner Tools 2016.2 are no longer supported as of January 2020.

Additional information on supported platforms is available at “Installation and Application 
Requirements” in the Tanner Administrator’s Guide.

RHEL Support
The Tanner 2021.2 release is the last release to support RHEL 6.8. Future major Tanner releases 
will only support RHEL 7.

Licensing
The Tanner Tools are currently installed with Mentor Standard Licensing version 2018_1 and 
FlexNet licensing version 11.14.1.3.
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If you encounter issues, please install the latest version of licensing software from Support 
Center.

Broken Links in PDF Documentation - 
(MG595892)

Due to enhanced security restrictions with web browser PDF plug-ins, some links do not 
function. Links in HTML documentation are fully functional.

Clicking a link within a PDF viewed in a web browser may result in no action, or it may load the 
title page of the current PDF manual (instead of the intended target in the PDF manual). The 

unresolved link behavior occurs in all web browsers on Windows® and Linux®1platforms. 
Because of this behavior, the navigational experience of PDF manuals is compromised. PDF is 
ideal for printing because of its page-oriented layout.

Use the HTML manuals to search for topics, navigate between topics, and click links to 
examples, videos, reference material, and other related technical content.

For information about Adobe’s discontinued support of Adobe Reader on Linux platforms and 
your available options, refer to Knowledge Article MG596568 on Support Center.

1. Linux® is a registered trademark of Linus Torvalds in the U.S. and other countries.

http://support.mentor.com
http://support.mentor.com
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Chapter 2
2021.2 Update 2

This chapter contains all of the enhancements and corrected defects for this release.

For more information, refer to the individual product manuals available from the InfoHub 
(Help > Help and Manuals) or from Support Center.

New Calibre® Interactive GUI. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9

Corrected Problems for ESI . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10

Corrected Problems for L-Edit  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10

Corrected Problems for Library Manager . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11

Corrected Problems for S-Edit . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11

Corrected Problems for T-Spice. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12

New Calibre® Interactive GUI
The default Calibre® Interactive GUI is changing to the new Calibre Interactive GUI for Calibre 
DRC, Calibre LVS, Calibre PERC, and Calibre PEX starting with the Calibre 2022.1 release.

If you need to switch to the old (classic) GUI, then you need to set environment variables in 
either the location where you run Calibre tools or via the User Environment section of the Setup 
Calibre Connection dialog box in the L-Edit tool, as shown in Figure 2-1.

If you set the environment variable to 1, then the tool uses the new GUI.

If you set the environment variable to 0, then the tool uses the classic GUI.

For more information, please refer to the Calibre Interactive User’s Manual and the Calibre 
Interactive (New GUI) User’s Manual on Support Center.

The 4 environment variables are:

• CALIBRE_ENABLE_NEW_CI_DRC

• CALIBRE_ENABLE_NEW_CI_LVS

• CALIBRE_ENABLE_NEW_CI_PEX

• CALIBRE_ENABLE_NEW_CI_PERC
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Figure 2-1. Setting Environment Variables for Calibre Interactive GUI

Corrected Problems for ESI
This section lists the fixed defects in this release of the ESI application.

• DR 54536 — Fixed a SQL ‘database is locked’ error that might happen when many 
simulation jobs are rapidly submitted.

Corrected Problems for L-Edit
This section lists the fixed defects in this release of the L-Edit application.

• DR 33636 — Fixed problem where Rule Aware Layout does not show violations 
between instances of the same cell.

• DR 51516 — Fixed problem when two users create a new layout view with the same 
name, and layout from first user is lost.

• DR 53785 — Fixed L-Edit Legacy LVL when layers with purposes are present.

• DR 54075 — Mouse zoom while dragging object no longer displays a phantom image 
of the object.

• DR 54078 — Multi-grid toolbar: snap grid button now commit edit box when the “Set 
snap grid” button is pressed.

• DR 54105 — Fixed crash while running a custom UPI macro, caused by External Text 
Editor.
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• DR 54122 — Fixed Crash on layout text generation by limiting text to 4095 characters.

• DR 54235 — Fixed problem where Calibre RealTime integration treats the current 
working directory as base for relative path to GDSII layer map file, rather than the 
location of the lib.defs or .tdb file. 

• DR 54243 — Fixed crash running L-Edit TDI when the cellname in TDI setup floorplan 
> Floorplan View Name drop down exists in multiple libraries.

Corrected Problems for Library Manager
This section lists the fixed defects in this release of the Library Manager application.

• DR 53761 — Very high CPU usage issue on Linux is fixed. 

Corrected Problems for S-Edit
This section lists the fixed defects in this release of the S-Edit application.

• DR 52201 — Corrected the number of pin connections for exported netlist subcircuit 
calls that refer to Verilog-A code consisting of port arrays dimensioned using macros, 
e.g. input [`ARRAYSIZE-1:0] bIn.

• DR 52373 — "Probe to schematic" now works with multiple schematic cell views. If a 
matching view is open, it is used, otherwise a warning is logged. 

• DR 52537 — Fixed EZwave voltage cross-probing with a reference.

• DR 52875 — Netlisting will now fail if shorted nets are found, with a user message, 
rather than proceeding to write a netlist containing shorts. The old netlist will be deleted 
prior to writing the new one. Placement of a new netlabel that creates a short will now 
issue a user warning. 

• DR 53355 — Fixed problems with EZwave freezing up when generating certain plots, 
such as histograms. Note that this fix requires use of AMSv  V2022.1.

• DR 53883 — Fixed Results Page plots to EZwave for Eldo simulations when the ‘Keep 
All Simulation Results’ setting is changed.

• DR 53984 — Double home click now fits the extent of the whole schematic.

• DR 54102 — Fixed a problem where the display of warning messages to the Command 
window is delayed.

• DR 54103 — Fixed problem where {Pop Out Reuse Window} does not reuse window 
when assigned using CTRL in bindkey.

• DR 54129 — Fixed problem where the TCL command design save -library <lib> -force 
deleted design data.
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• DR 54158 — SPICE.PINORDER property is now obeyed for Calibre source export.

• DR 54185 — Multi-line text labels are truncated when displayed, if they contain an 
empty line.

• DR 54358 — Spectre netlister now writes the global statement prior to altergroups 
instead of after.

• DR 54483 — Fixed case where schematic gets modified without a reservation after 
zoom operation.

Corrected Problems for T-Spice
This section lists the fixed defects in this release of the T-Spice application.

• DR 45648 — Relocated the digital simulator .vcd output file to the simulation results 
folder instead of its parent directory.

• DR 51385 — Fixed certain DC sweep measurements when .measure results are chained 
into other .measure calculations.

• DR 54135 — Corrected convergence problems due to invalid M scaling of derivatives 
for VCR devices (g<name> node1 node2 VCR …).

• DR 54271 — Removed erroneous ‘current density’ warning messages for R3_CMC 
resistors during DC and parametric sweeps.
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Chapter 3
2021.2 Update 1

This chapter contains all of the enhancements and corrected defects for this release.

For more information, refer to the individual product manuals available from the InfoHub 
(Help > Help and Manuals) or from Support Center.

Enhancements for L-Edit  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13

Enhancements for Library Manager . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13

Corrected Problems for ESI . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13

Corrected Problems for L-Edit  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14

Corrected Problems for Library Manager . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14

Corrected Problems for Revision Control. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15

Corrected Problems for S-Edit . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15

Corrected Problems for T-Spice. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16

Corrected Problems for Tanner Designer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17

Enhancements for L-Edit
This section lists the enhancements available in this release of the L-Edit application.

• ER 53354 — TDI no longer sends LEF/DEF/PTF/Liberty/RTL files to remove Linux 
server if those files already exist on the server.

Enhancements for Library Manager
This section lists the enhancements available in this release of the Library Manager application.

• ER 53588 — Now Version Control status of active library definition file is being 
refreshed automatically when implicitly modified during library creation, copy, rename, 
and delete operations.

Corrected Problems for ESI
This section lists the fixed defects in this release of the ESI application.

• DR 52853 — EZwave is now opened on the correct host when there are multiple saved 
settings in ESI dialog box.
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• DR 53415 — Improved the error recovery and error messaging for remote host 
connection failures.

Corrected Problems for L-Edit
This section lists the fixed defects in this release of the L-Edit application.

• DR 52973 — Fixed crash when double-clicking the layer for which Area is set on the 
Derivation tab.

• DR 53137 — OASIS Export/Import is now handled correctly when a cell with same 
name is present in two different libraries.

• DR 53298 — Fixed problem caused by second period in filename when opening a GDS 
file.

• DR 53337 — GDSII import log header now contains Target library, Overwrite cells, 
and Search for cells.

• DR 53341 — 2D array port names A<1><2> are now correctly preserved. 

• DR 53387 — Fixed saving Special Layers when they are on a real purpose, not the 
Legacy purpose.

• DR 53423 — Fixed export DEF for legacy ports.

• DR 53442 — Synchronize Schematic Selection now opens the associated schematic.

• DR 53455 — Improved performance of GDSII import when a layout view is open.

• DR 53697 — Fixed updating from callbacks in the Edit Objects dialog – when changing 
property to an invalid value, the property would return to the default value rather than 
the previous value. Also fixed the “<Multiple>” display when remastering multiple 
instances.

• DR 53835 — Fixed problem importing some display.drf files by allow functions with > 
10000 arguments in the lisp interpreter.

• DR 53907 — Edit instance dialog is now correctly initialized based on default values in 
CDF.

Corrected Problems for Library Manager
This section lists the fixed defects in this release of the Library Manager application.

• DR 53506 — Fixed a crash by enhancing the implementation to handle the case when 
Cellview contains more than one primary file representing different view types.

• DR 53514 — Fixed the viewTypesToCopy and viewsToCopy options of cell copy 
operation to work like the same options of library copy one.
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Corrected Problems for Revision Control
This section lists the Revision Control fixed defects in this release.

• DR 53580 — Fixed library creation, copying, renaming, or deletion, as well as active 
library definition file editing operations in Library Manager to cancel their execution in 
an SVN working copy, if active library definition file is repo locked in a different 
working copy.

Corrected Problems for S-Edit
This section lists the fixed defects in this release of the S-Edit application.

• DR 50837 — Corrected the Probe to calculator operation which was plotting values 
instead of sending the waveform name to the EZwave calculator.

• DR 51096 — Added support for EZwave calculator to S-Edit. When the S-Edit toolbar 
is set to probe to "Calculator", and the waveform viewer is EZwave, S-Edit can now 
probe to the EZwave calculator.

• DR 51837 — S-Edit now relaunches EZwave when probing if it finds EZwave is no 
longer present.

• DR 52051 — Fixed problem with Simulation progress tooltip not working after a while.

• DR 52956 — T-Spice related setup is no longer exported to simulation for AFS 
simulator.

• DR 53266 — Do not change focus from S-Edit to the previously focused app when a 
simulation completes.

• DR 53335 — Fixed probing of digital signals from Symphony simulations.

• DR 53365 — Fixed problem where Spectre NOISETRAN parameters get exported even 
if it's unchecked by user, but multiple runs is set to some value.

• DR 53394 — Fixed problems with switching between local and remote simulations 
display of EZwave.

• DR 53406 — Corrected the behavior of the EZwave calculator Send Expression 
operation for simulations with Keep all simulation results enabled.

• DR 53425 — It is now possible to create a new view to resolve an unresolved view.

• DR 53477 — Corrected remote EZwave launch failures when the user switched 
between different host Saved Settings in ESI.

• DR 53490 — Design Check no longer causes extra views to be loaded. This could 
improve performance of design check if large views were being unnecessarily loaded.

• DR 53491 — Fixed excessive refreshing of S-Edit Add instance dialog box.
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• DR 53501 — Fixed relative path when browsing for Spectre Libraries in Setup 
Simulation dialog box.

• DR 53524 — Fixed problem with text label evaluation system property when 
exchanging data with previous versions.

• DR 53557 — Extracting parameters no longer add “)” to the end of a parameter.

• DR 53590 — Fixed Design check for symbol view missing pin warnings.

• DR 53651 — Do not automatically launch the EZwave calculator when Results page 
expressions are calculated.

• DR 53670 — Fixed problems in the place instance dialog. When placing an instance, 
the instance dialog is now correctly initialized with default values from CDF. Invisible 
properties from CDF now respond to callbacks of other properties. Fixed problems 
when dragging instance across one schematic window to another when placing an 
instance.

• DR 53758 — Improved performance when setting multiple design checks does on large 
views.

• DR 53734 — Fixed problem updating the instance dialog when placing instances in 
succession. 

• DR 53781 — Fixed editing of instance properties by Ctrl+Right-click on the property 
on the schematic work area.

• DR 53868 — Simulations dialog 'Rename' fails for Eldo simulations, when we have 
signals in the Waveform Results page.

• DR 53874 — Fixed Publish to SDL on Linux when symbolic links are used.

• DR 53978 — Improvements in S-Edit log performance have been made. This 
significantly improves performance running simulations from S-Edit that produce large 
amount of log data, in particular when log limits in ESI and S-Edit are set to large 
values.

Corrected Problems for T-Spice
This section lists the fixed defects in this release of the T-Spice application.

• DR 52511 — Added a new option maxwarnstolog to limit just the number of .assert 
violations that are printed to the screen and log file. maxwarns messages will still be 
printed to the .assert file. Limiting log messages will improve performance when many 
messages are logged. 

• DR 53509 — Fixed a T-Spice GUI crash at the end of a Verilog-AMS simulation.
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• DR 53583 — Fixed a T-Spice GUI crash when exiting the application while a queue of 
simulations are running.

Corrected Problems for Tanner Designer
This section lists the fixed defects in this release of the Tanner Designer application.

• DR 49552, 53489 — Corrected the simulation Status display column to properly track 
the progress of running simulations.

• DR 52923 — Tanner Designer no longer  holds an exclusive lock on the  sqlite 
database.

• DR 53280 — Corrected the grouping of date/time-stamped Keep All Simulation Results 
solutions (e.g. name_20211002_123045) in relation to user-named files ending in 
numbers (e.g. name_v2_2_1).

• DR 53281 — Corrected empty Netlist and Schematic Design path fields on Linux.

• DR 53451 — When simulations are run from Tanner Designer, the simulation measures 
from the S-Edit Results page Calculator expression definitions, are now computed at the 
end of simulations and are displayed correctly in Tanner Designer.

• DR 53487 — When completing a simulation the fields such as host, netlist, etc now 
update automatically.

• DR 53488 — Made corrections and improvements to the Retarget path… operation for 
fixing invalid simulation paths.

• DR 53496, 53256 — The detailed results for AFS corner analysis will now show 
columns for Library values.

• DR 53496 — The detailed results for Eldo PVT and corner analysis will now show 
columns for Libraries and all variables.
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Chapter 4
2021.2

This chapter contains all of the enhancements and corrected defects for this release.

For more information, refer to the individual product manuals available from the InfoHub 
(Help > Help and Manuals) or from Support Center.

Enhancements for L-Edit  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19

Enhancements for Library Manager . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20

Enhancements for S-Edit  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21
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Enhancements for L-Edit
This section lists the enhancements available in this release of the L-Edit application.

• ER 40173 — ODB++ Import and Export is now available in L-Edit.

• ER 42553 — Alignment operations “Distribute Horizontally” and “Distribute 
Vertically” now preserve columns and rows when objects are initially aligned in 
columns or rows.

• ER 42896 — Synchronize Selections from Layout to Schematic and visa-versa now 
works for multiple selected objects.

• ER 45340 — Integrated support for 3rd party text editors is now available in S-Edit and 
L-Edit for editing text views (Spice, Verilog, VHDL) as well as various text and log 
files. See Setup Application > Text Editor for setup. Pressing the Ctrl Key when 
opening a text view or file will open the opposite of the default choice.
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• ER 50550 — Router now supports the end of line spacing rule with the parallel object. 
LEF line: SPACING 0.10 ENDOFLINE 0.09 WITHIN 0.020 PARALLELEDGE 0.10 
WITHIN 0.07 ;

• ER 51302 — Nudge now permits different distances in x and y.

• ER 51546 — Mouse grid snapping may now be set on a per-layer basis. Per-layer grid 
settings are on a new “Grid” tab in Setup Layers. Per layer snapping may be turned on/
off in the Multigrid toolbar Settings dialog box.

• ER 51765 — Port Utilities > Convert labels to ports now allows specification of 
Length and Width to create rectangular ports, rather than only square ports.

• ER 51876 — The “Snap to manufacturing grid” command has been enhanced to provide 
options to snap to the per-layer grid or the default mouse snap grid, and has been 
renamed to “Snap to grid”.

• ER 52077 — The Setup Tanner Digital Implementer > Netlist/RTL page now 
contains a “List File” option to setup the list of Netlist/RTL files, rather than entering 
them individually in the UI.

• ER 52106 — When editing, the SHIFT key forces horizontal or vertical editing, and the 
CTRL key forces 45-degree editing. Once you begin one of these edits, you can now 
also hold down the ALT key, then the direction of the edit is "locked".

• ER 52445 — The Calibre Connections Dialog now contains an option to set the Calibre 
Realtime License. Options are Tanner Calibre One, Calibre RealTime custom lite, or 
Calibre RealTime custom.

• ER 52507 — L-Edit now respects the read-only setting in the .oalib file in the library 
folder.

• ER 52520 — The Multigrid toolbar has new buttons to set the grid and grid offset by 
clicking on the layout rather than entering values. There is also a new “Settings” button 
that displays the settings for all the grids. 

Enhancements for Library Manager
This section lists the enhancements available in this release of the Library Manager application.

• ER 44286 — Library Manager is a new stand-alone application that provides OA data 
management capabilities for layout and schematic in a unified environment. Within 
Library Manager, users can:

o Create, copy, rename, delete libraries, cells, views, categories, and properties

o Launch schematics and layouts

o Replace instances in libraries, cells, and views
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o Edit technology references for libraries

o Create and edit lib.defs files

o Sort, filter, and organize data

o Integrate Revision Control tools (SVN, Perforce, Cliosoft

• Create new working copies

• Manage, lock, and commit selected libraries, cells, views, and files

• Review repo locked views and files to commit or unlock them

Enhancements for S-Edit
This section lists the enhancements available in this release of the S-Edit application.

• ER 38690 — A new TCL command “workspace getcursorposition” returns the current 
cursor position on the schematic. Optional -prompt argument shows a temporary prompt 
dialog and -command argument calls "command" with x and y.

• ER 45340 — Integrated support for 3rd party text editors is now available in S-Edit and 
L-Edit for editing text views (Spice, Verilog, VHDL) as well as various text and log 
files. See Setup > Preferences > Text Editor and Styles > Text Editor for setup. 
Pressing the Ctrl Key when opening a text view or file will open the opposite of the 
default choice.

• ER 45558 — Performance opening a cell view has been improved by only loading cells 
for the view itself, rather than loading all views in the hierarchy. Views in the hierarchy 
will need to be loaded for netlisting and design checks.

• ER 49005 — S-Edit is now able to setup Technology Referenced and Attached libraries 
when creating a new library, as one can do in L-Edit. 

• ER 50576 — S-Edit now has Autosave, as was already present in L-Edit. Autosave 
saves backup files for each modified view, which are used to recover lost work in the 
event of a program crash or when closed improperly.

• ER 50872 — Setup Simulation > Parameters now has the ability to search the View 
or the hierarchy for undefined parameters and automatically add them to the parameters 
table.

• ER 51011 — Schematic Compare allows comparison between 2 schematic views or 2 
symbol views. Differences are summarized and automatically zoomed and highlighted 
in the schematic canvas. Identifying differences between different versions of a 
schematic/symbol is useful in design flows or ECO flows when you need to determine a 
cause of failure.
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• ER 51219 — A close.design folder in %AppData%\Tanner EDA\scripts is now 
supported, which executes user-defined scripts upon closing of a design. 

• ER 51292 — Parsing of Spice views now has three modes that can be used to control 
performance. The three modes are:

o full — parse the entire netlist

o interface — only parse interfaces

o none — do not parse the netlist

The mode is automatically chosen, but can be overridden by placing a property on the 
view called “PARSE” with one of the above values. Verilog and VHDL views have 
“full” and “none” modes, but do not support “interface”.

• ER 52732 — The “tech report” TCL command reports attached and referenced libraries 
for the database. It can also create attachments and references. This command 
previously existed as “test oatech”.

• ER 52751 — The lock icon in the library navigator now represents both the no-edit 
setting and the read-only setting in the library .oalib file.

• ER 52826 — In Setup Simulation, the column headers of disabled corners are now 
displayed in gray for better visualization.

• ER 52865 — The simulation toolbar has been redesigned to move database related 
buttons onto a separate “Design” toolbar, and to organize the simulation buttons into 
more clear groupings. 

A new “Select Simulations” button has been added that invokes a dialog that lists all the 
simulations for the current testbench. From the simulations dialog one can load other 
simulations and perform various other operations. 

A new “Waveform Viewer” button is added to the toolbar to launch the appropriate 
waveform viewer for the current simulation.

• ER 52864 — A list editor dialog box has been added in the Setup Simulation dialog box 
to improve editing of the following: 

o File search paths

o Include files

o Library files

The Library files editor has two columns, the library file and the section name. The 
section name has a drop down which is prepopulated from the sections in the.lib file, but 
can also be typed into.

• ER 52979 — Right click > Copy Link Target on a file or folder link in the S-Edit 
command window copies the link to the clipboard.
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• ER 52959 — Netlisting of parameter and temperature sweeps inside corners now 
preserves the sweeps inside the corners, resulting in a much more compact netlisting. 
This allows EZwave to understand and plot the parameterization correctly.

• ER 53199 — Library Sections in the Setup Simulations > Corners tab are now auto-
populated in a dialog box, allowing the user to choose from available sections in the 
library file.

Enhancements for Tanner Designer
This section lists the enhancements available in this release of the Tanner Designer application.

• ER 52960 — For a corner setup in Setup Simulation with multi-corner/sweeps, Tanner 
Designer will now aggregate them as a single cluster in Tanner Designer.

Corrected Problems for ESI
This section lists the fixed defects in this release of the ESI application.

• DR 47866 — Upgraded the Putty ssh tool to version 0.73 to correct security 
vulnerabilities.

• DR 52050 — Eliminated intermittent error “Environment variable %APPDATA% not 
defined”.

Corrected Problems for EVI
This section lists the fixed defects in this release of the EVI application.

• DR 51269 — Fixed problem exporting schematic running Calibre xACT the first time.

Corrected Problems for L-Edit
This section lists the fixed defects in this release of the L-Edit application.

• DR 35892 — Fixed problems using object snapping to align objects.

• Dr 39335 — The “database open” TCL command now supports options to open gds, 
gerber, dxf, cif, oasis, and odb++ files.

• DR 47220 — Fixed problem where LC_Generate returned an error instead of generating 
the specified instance.

• DR 48070 — Guard Rings imported from other tools are now tagged so that "select", 
"delete", "convert" functions work.

• DR 49071 — Standard and Custom vias definitions may now be deleted.
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• DR 49990 — Fixed problem where LInstance_SetParameters UPI command did not 
change instance parameter.

• DR 51221 — Fixed minimum metal area issues in SDL auto-router.

• DR 51453 — Fixed Minimum Metal area DRC error in SDL router.

• DR 51648 — Fixed minimum width routing errors in SDL auto-router.

• DR 51759 — Improved accuracy of routing in SDL auto-router using LEF spacing table 
for the parallel length routing.

• DR 51857 — Added support for the LEF MINIMUMCUT statement in the SDL auto-
router.

• DR 52294 — Fixed rotation and flipping bitmap images when printing in the vector 
mode.

• DR 52504 — Fixed problem changing the name of a port, when ports contains box, port 
and label objects, and port and label objects are on different layer.

• DR 52569 — Fixed problem closing L-Edit after running the "Regenerate T-Cells and 
Vias" command. This also fixes hang after adding a standard via template and closing 
the design.

• DR 52576 — Fixed crashes when printing.

• DR 52920 — The GDS spec states that number of columns and the number of rows in 
an array must be in the range 0 to 32,767. L-Edit now warns if this number is exceeded, 
but will allow you to read and write up to 65,535. There is no guarantee that any other 
tool will correctly process this data.

• DR 52989 — Fixed crash in “Find in Hierarchy” when “Ports” and “Labels” are both 
checked.

• DR 53101 — Fixed problem where import DEF generated wrong pattern due to non-
standard database resolution.

Corrected Problems for Revision Control
This section lists the fixed defects in Revision Control in this release.

• DR 48091 — SVN performance improvements.

• DR 51599 — SVN version 1.6.x only: Not able to manage a view after unmanage.

• DR 51642 — SVN: Version Control update hangs indefinitely.

• DR 51703 — SVN version 1.6.x only: Library Update/Refresh doesn't show VC related 
information in Navigator's columns.

• DR 52009 — Perforce: Crash when calling update library that has an alias name.
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• DR 52487 — SVN/Cliosoft SOS/Perforce: Cellview folders become empty, when 
copying a cell with manage option, then closing and reopening S-Edit.

Corrected Problems for S-Edit
This section lists the fixed defects in this release of the S-Edit application.

• DR 48444 — Descriptions in Setup Simulation > Parameter are now saved.

• DR 50627 — Fixed crash editing image on custom toolbar button.

• DR 51064 — Designs with Japanese characters in the path can now be opened in S-Edit. 
Locale will need to be Japanese, and lib.defs file should not contain Japanese.

• DR 52246 — Fixed problem where changing a parameter on an instance, and then 
changing that parameter on other instances of the same cell, callbacks would not update 
parameters. 

• DR 52634 — Non-default path color is now preserved after saving.

• DR 52456 — Clicking on a double property in Properties toolbar in evaluated mode no 
longer marks the database modified.

• DR 52562 — Fixed various problems reserving, revert, and updating text views (spice, 
Verilog).

• DR 52650 — Fixed problem when mouse zoom on a Text label which was duplicated, 
the text label disappeared.

• DR 52799 — Fixed problem where Setup Simulation dialog does not appear when 
"Prompt before reservation on first edit is set to Managed Cells Only" and the view is 
not already reserved.

• DR 52802 —Fixed Selection Synchronization to work correctly with schematics that 
contain multiple pages.

• DR 52867 — Fixed bindkeys associated with user toolbar buttons.

• DR 52877 — Fixed problem where creating then deleting a Verilog view in an existing 
cell caused the schematic view to also be deleted.

• DR 52899 — Fixed crashes when annotation is reloaded and displayed at the 
completion of a simulation.

• DR 52908 — Generate Symbol dialog initializes with active view when possible.

• DR 52957 — Improved performance opening Setup simulation is when the simulation 
results folder contains a large number of simulations.
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• DR 53033 — Temporary *.tmp.vhd files are now deleted after running symphony. This 
may solve timeout issues caused by copying large numbers of extra files to the remote 
server.

• DR 53066 — Fixed problem when crossing probing, wrong sim results were loaded in 
W-Edit, if CurrentTestbench is set to default 'Spice'.

• DR 53148 — Fixed saving of port locations to OA for compatibility with other tools, 
where port locations appeared slightly offset in other tools. Databases saved in previous 
versions will appear unchanged in this version. Databases saved in this version will have 
ports snapped to the closest wire endpoint or pin, within a halo of the port instance MBB 
when opened in older versions.

Corrected Problems for T-Spice
This section lists the fixed defects in this release of the T-Spice application.

• DR 44633 — Permit the .malias command to reference a subcircuit name in place of a 
model name.

• DR 51139 — Corrected T-Spice Simulation > Device Parameters... listings for a 
number of device types and models.

• DR 52689 — Fixed S-Edit annotation and cross-probing problems when a simulation is 
renamed in T-Spice.

• DR 52752 — Corrected the tspcmd shell executable to generate the 
<sim_name>.tsiminfo file for S-Edit and Tanner Designer processing.

• DR 52889 — Allow a print statement expression to refer to a previous named print item, 
e.g. .print Vout=V(Out) Times2=’2*Vout’.

• DR 52952 — Allow user-defined functions that have no arguments.

Corrected Problems for Tanner Designer
This section lists the fixed defects in this release of the Tanner Designer application.

• DR 49887 — Performance of aggregating or updating simulation results on Linux.

• DR 52830 — Corrected the grouping of measurement statistics for AFS PVT and corner 
analysis testbenches.

• DR 52692 — Launching EZwave from Tanner Designer will now display the correct 
initial Results plots.
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Corrected Problems for Waveform Viewer
This section lists the fixed defects in this release of the Waveform Viewer application.

• DR 50655 — Fixed selection/deselection of markers.
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Chapter 5
Getting Help

Application and online help is available from technical support and documentation.
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Global Customer Support and Success
A support contract with Siemens Digital Industries Software is a valuable investment in your 
organization’s success. With a support contract, you have 24/7 access to the comprehensive and 
personalized Support Center portal.

Support Center features an extensive knowledge base to quickly troubleshoot issues by product 
and version. You can also download the latest releases, access the most up-to-date 
documentation, and submit a support case through a streamlined process.

https://support.sw.siemens.com

If your site is under a current support contract, but you do not have a Support Center login, 
register here:

https://support.sw.siemens.com/register

Documentation
These release notes and the accompanying Tanner Tools documentation are available through 
multiple resources.

View the Tanner Tools documentation from the following locations:

• Application help through the Help > Help and Manuals to invoke the InfoHub 
documentation portal.

• On Support Center under the Documentation tab for Tanner Tools releases.

https://support.sw.siemens.com
https://support.sw.siemens.com/register
https://support.mentor.com
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Third-Party Information

Details on open source and third-party software that may be included with this product are available in the
<your_software_installation_location>/legal directory.
Note - Viewing PDF files within a web browser causes some links not to function. Use HTML for full navigation.
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